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Getting Started 
Introduction 
Beagle Software SlideShow lets you create multimedia shows and play 
them using your web browser. Shows can be made up of a combination of 
your favorite web pages, images or documents accompanied by your 
favorite music or voice-over.   Create, run and edit your own shows easily 
using your existing web browser. Use SlideShow as a presentation engine, 
a training tool or an image album. 

SlideShow 
• Is a presentation engine for Internet Explorer or Netscape 

Navigator.  

• Automates web and image viewing.  

• Lets you automatically channel surf your favorite web sites. 

• Lets you create themed tours of the web.  

• Lets you share your web experience with others. 

• Lets you create stand alone web shows. 
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Benefits 

Easy to use 

• It’s easy to make a show from images, web pages or HTML 
documents. 

• Uses the browser you already have and know how to use.  

• Shows can be any kind of file or format supported by 
browser.  

• Shows can be created and saved for future showings. 

• Sound files use computer’s sound card. Sound files can be 
played and recorded on the fly. 

• Use your favorite tools to create slide content. 

Multiple presentation options  

• Full screen mode  
Full screen images are great for presentations or displaying web pages 

• Continuous play 
Play slides in a continuous loop. 

• Auto re-load 
Reloads and refreshes the same web page at defined interval. 

• Random play 
Plays slides in random order 

• Auto Start 
Start SlideShow automatically from the command line for hands free opera-
tion. 

Making Shows 

• Shows are made up of a collection of slides. 

• Slides consist of a reference to  image, URL or text. Slides 
can also have an accompanying sound file.  

• Slides can be added, edited, skipped or deleted from shows 
anytime. 

• Multiple shows can run concurrently in different browser 
windows. 

• Add slides singly or make show from directory of existing 
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images. 

• Save shows to file for later use by SlideShow or save as HTML 
files accessible from any browser.  

Show Presentation Options 

• Sequential or random slide selection during show play. 

• Once or continuous action lets you control play. 

• Individually timed or default timed slides gives you control on 
how long a specific slide will be shown.  

• ‘Wait till done” option waits for all elements of a file to load 
before continuing – useful for web documents. 

• Full screen mode gives a theatre like presentation covering the 
entire display screen.  

Requirements 

• Internet Explorer or Netscape Navigator. Also supports other 
DDE compliant browsers. 

• Windows 95/98 or Windows NT/2000 

• Sound card needed for sound file playback and recording.  

 

Quick Start        
To get SlideShow up and running:  

1. Install SlideShow.  

2. Make sure web browser is installed 

3. If using web pages then make connection to the Internet. 

4. Start SlideShow program. 

5. Press the “Show” button.  

6. The demonstration slide show will start and run through a quick 
introduction.  

To create a new show, use the new show wizard found under the 
Wizard menu. 
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Software Installation 
 

To install SlideShow: 
1 Place the CD-ROM in the drive. Installation will start automatically 

when the CD-ROM drive is closed. 

2 You can also start the CD-ROM manually. From the Windows Start 
menu in the lower left corner select the Run command from the menu 

3 Enter  x:\setup  in the Open box where x is the drive letter used 
(typically D or E). Press OK 

4 Follow the instructions from the installation wizard. For a typical 
installation you can accept all defaults offered by the wizard.  

5 When asked for the key code, enter the key code you copied 
down (above) exactly as written in the Enter Code screen on the 
registration page, or if already in SlideShow choose the 
Register option under the Help menu.   
Key codes are case sensitive. 

6 If requested, you may need to reboot the system to install the 
new DLLs that were just installed.  

7 When installation is complete, Start SlideShow from the  
Start/Programs/Beagle Software/SlideShow  menu. 

8 SlideShow will inform you that it is initializing options for the first 
time. 

Installing SlideShow options version X.X.
X, for the first time 

Note: If necessary you can install SlideShow directly over a 
previously installed version. Some SlideShow Options have 
changed so you may need to reset some time setting or display 
options after starting the new software. 
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Software Removal 
Removing SlideShow from a system will remove all executables, help 
files, log files, registry settings and DLL’s that are registered 
exclusively to SlideShow.  
 

To Remove SlideShow 
To perform an uninstall of SlideShow: 

1 If running, exit SlideShow. 

2 Select the Uninstall program (uninstall.exe) from the  

Program Files -> Beagle Software -> SlideShow  directory. 

3 Follow the uninstall wizard. Accept the defaults. 

4 If asked if you want to remove shared DLL’s — it is safest not to 
remove the DLL’s in case they are in used by another program. 

 
 
Program Reference 
Main Screen 
The SlideShow main screen is the focal point for opening, editing and 
running slide shows. The main screen serves as the central point where 
the slide show is created and run 
 
When the main screen is started it starts an instance  of the web browser 
you have selected for displaying slides. A linkage is established between 
SlideShow and the browser that allows SlideShow to control the content 
and appearance of the browser session.  The browser can still be 
separately administered but SlideShow will take control of the session 
when requested.  
 
The main screen is made up of several functional sections stacked atop 
one another. These are (from top to bottom), Menus, Control, Show, Slide, 
Option and Status. 
 

 Menus  

(see the menu reference that follows) 
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Control Section (remote control button) 
   Contains the navigation controls.  

Remote Control button 
During a show the remote control button is enabled to go back, 
pause and forward in a show using the mouse buttons: 
Left button goes back to the previous slide. 
Center button  pauses the show.  
Right button  advances to the next slide.  

Control Buttons 
 Begin  Go to beginning of show (show mode only).  
 Back   Go back to last slide shown.  
 Pause  Pause/restart slide show (show mode only).  
 Forward          Go forward one slide.  
 Ending            Go to end of collection (show mode only). 
 Stop    Stop current action (show mode only).  

Show Section (movie button) 
Controls to start slide show and display show progress. 
       Show Button 

Begin the slide show with the options selected. 

      Show toolbar 
Open Opens a dialog to choose an existing SlideShow file.  
Edit    Opens the current SlideShow in the Show Editor.  
 

         Change slide arrows  
Change the slide number up (right arrow) or down (left arrow). 
This control positions the next slide to show. To display the 
slide, press the Slide button or start the show by pressing the 
Show button.  

      Show Slider 
Drag slider to change the current slide. If activated during a 
show it will change the next slide to show. If the show is not 
active then press the Slide button to show the current slide. 

 
Tip: The main program icon in the upper left corner of the 
application shows the state of the show:  

Green: show is running  
Yellow: show is paused  
Red: show is stopped.  
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Slide Section (film button) 
Controls to view and edit an individual slide.  

      Slide Button 
Displays a single slide in the browser. 

      Slide toolbar 
Open Opens a new slide document.  
Edit Edit the current slide settings in the Edit Slide screen.  
Reload Reloads (refreshes) the current document in the browser. 
Auto-reload. Reloads the current slide automatically at the 
default pause time specified.  

 
      Slide file  pull-down 

Selects a slide to show. Slides can be entered in the box or 
retrieved from the pull down button, which shows the last several 
documents presented to the browser.  

      Sound file  label 
Shows the optional sound file playing with slide.  

      Pause time label 
Pause (in seconds) to wait after displaying slide 

 
Hint: Clicking on the sound file or pause time box opens up the Slide Edit 
screen.  

Option Section (check button) 
Contains the slide show presentation options, which affect how the slide 
show is run.  
 

Operation:               How many times to run.  
         Once               Run the collection once. 
         Continuous     Run the collection continuously. 
 
Order:                     Order options: Sequential, Random 
      Random             Run the collection in random order. 
      Sequential         Run the collection in order. 
 
Loading:                  Behavior of browser when loading slides. 
       Auto Start         Start current show automatically the next time starting Slide-
Show. 

       wait till done     Wait till slide is done loading before loading next slide. 

 



11 

SlideShow User’s Guide 

Default Pause:        Set default time to pause for all slides. 
       Pause Interval  Specify the default interval between slides. 
       use default       Override the individual slide pause time with the default. 
 
Save to file… 
         Save the current options to a file which can be used as an instruction file when 
starting SlideShow . 

 
Browser  
        Select the browser you want to use with SlideShow . 

Status Section 
Contains the status bar, which provides information about system status 
and individual field instructions. 

      Status Bar 
Shows system status and field instructions. 

Menus 
File Menu 
Actions for SlideShow collections and program exit. 
      New          

Create a new instance of SlideShow or a slide collection 
SlideShow Window            

Create a new SlideShow application / browser pair.  

New Show    
Create a new, empty slide collection. Opens the Edit Show 
screen.  

Make Show from Directory 
Make a SlideShow collection from a group of files in a 
directory. Create a slide for each file in the directory. 
Opens the Make Show from Directory screen.  

     Open         
Open an existing show. Presents user with “Open File” screen 
and allows selection of an existing show, saved as a text file 
(with a .txt suffix). If there is a show open with un-saved 
changes it asks user if the changes to the current show should 
first be saved.  

      Edit           
Edit the current show. Opens the Edit Show screen. 
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     Save        
Save the current show to file.  

      Save As… 
File - Save the current show to a file name selected in the 
“Save As” file dialog. 

Web Show – Opens the Make Web Show screen, used to 
create a web show from the current collection.  

       Import and Export… 
Import Bookmarks Select and import an existing bookmark fi le 
to use as a basis for a new slide show. 
Export Bookmarks Export the current show as a bookmark file 
to be opened and used in a web browser . 

      Exit         
Exit the current window, if the last window, exit the application. 
Prompts user to save changes to the show or changes to the 
settings, if either have been altered during the session. 

Wizard Menu 
Calls up the Wizard Start screen containing the new show wizard 
and recent show list. On the Recent tab you can select an existing 
show. Starting the new show wizard guides you through creating 
a new locally-based or web-based show.  

Slide Menu 
Single slide commands. View or edit individual slides in a show. 

        Open         
Select a new slide document.  
Pick any file type supported by the browser.  

 
      Edit              

Edit the existing slide by opening the slide edit screen. 
 

View Menu 
Display options for the main screen and browser.  
 

Sections with a check are displayed in the main screen; unchecked 
sections are hidden. 

 
Menu              
   Hide the menus on the main screen. 
Control                      
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   Display/hide the Control section on the main screen. 
Show             
   Display/hide the Show section on the main screen.  
Slide                          
   Display/hide the Slide section on the main screen.  
Options                      

Display/hide the show Options section on the main screen. 
Status 
   Display/hide the status bar on the main screen.  
 
Tip: Sections can also be displayed/hidden by clicking on the thin 

blue rectangle at the left or top of the section.  
 

Always on top            
Force the main SlideShow screen to be on top of all other 
screens. The main screen will appear in all views no matter 
which application is in focus. 

Full Screen                
Enters the full screen browser mode. In this mode the 
browser fills the entire screen except for a Control Bar at the 
top of the screen which offers control options . This view is 
appropriate when you want the web page or image to 
completely fill the screen.  
 
Note: Currently this mode only works with Internet Explorer 
version 4 or 5 under Windows 95 or 98.  
DDE automation does not currently support the Full Screen 
mode. On browsers that don’t support this mode the Full 
Screen Control bar is displayed with the menus shown.  The 
full screen mode  can be simulated on these browsers by 
maximizing the browser screen and hiding the toolbars and 
menus.  

 

Mode Menu 
Select the mode of operation that SlideShow is currently running in. 
      Normal        

System is waiting for command. 
      Auto-Reload            

Reload the current slide at the specified pause time interval. 
      Show           

Toggle the Show mode On/Off. When checked system is cur-
rently running a slide show.  
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Control Menu 
Changes which slide is shown in browser during a show.  With the control 
buttons you can move forward or back, pause or stop the currently open 
show.  
 
      Beginning   

Go to the first slide in the show.  
      Back                        

Go back to last slide shown.  
      Pause           

Pause/restart slide show.  
      Forward      

Go forward one slide.  
      Ending                    

Go to the last slide in the show. 
      Stop                        

Stops current show or reload action – entering into the ready 
mode.  

      Reload        
Reloads the current image, document, or URL.  

Options Menu 
Options for the active slide show presentation. When changed, most 
options take effect on the next slide shown.  

Operation     How many times to run the show. 
        Once                     

Run the show once. If currently in the sequential order mode 
SlideShow will play each slide once. In the random order mode 
SlideShow will randomly pick slides till the count equals the total 
number of slides in show. 

        Continuous                       
Run the show continuously. 

Order              Run the slides in serial or random order. 
        Sequential                         

Run the collection in the numeric order specified in the show.  
        Random                

Run the collection in random order. Since the random slide is 
generated for each successive slide, certain slides may be 
repeated or omitted over the course of the show..  
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Loading      Behavior when loading slides. 
          Auto Start 

Starts current show automatically the next time you start 
SlideShow 

         wait till done         
Wait till slide is done loading before loading next slide. The 
timing of the slide begins when the slide begins to load. If 
wait till done  is selected, the system will pause for the time 
specified or till the slide is finished loading, whichever is 
longer.  

Pause         Default time to pause for all slides . 
         use default                       

Override the individual slide pause time with the default time 
specified. 

Tool Tips     Choose if tool tips are to be displayed.  
Tool tips provide additional ‘pop-up’ information about the control 
or field on the form. 

         On                        
Display tool tips for all screen components.  

         Off                        
Turn off tool tips. 
 

Save to file..   Save options in a  instruction file.  

Saves the current options settings as a show instruction file. 
Presents a dialog to choose the filename and location of the 
file to save. 

Browser         Change linked browser.  
        Opens the Browser type screen to specify browser type. 

Help Menu 
On-line help options and access to the Beagle Software web site. 

Help Topics 
Displays a list of help topics. 

Search 
Search the help system for a key word or topic 

Using Help 
How to use help. 
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Tips 
Opens the tip of the day Tip Screen  

Beagle Software Web Site  
Opens a new web browser window which opens Beagle 
Software's home page.  

Register… (Trial version) 

Opens the main Registration Screen, which explains registration 
options. 

 
Upgrade Software 
Opens a new web browser window which opens the SlideShow 
software update page. This page contains information about the 
most current version of SlideShow and the upgrade options  
available. 

About 
Displays program version, system and program copyright 
information.  

 

Full Screen Control Bar 
When in the full screen mode the browser fills the entire screen except for 
a thin band across the top of the screen. This band (normally black) is the 
control bar which provides access to the basic show navigation functions 
in SlideShow. This control bar consists of control and view menus ac-
cessed from the left and right click mouse buttons, respectively. The con-
trol bar allows you to control the slide show currently running in the 
browser window without displaying the main SlideShow screen.  

Note: Currently this mode only works with Internet Explorer version 4 or 5 
under Windows 95 or Windows 98. 
DDE automation (used with Netscape) does not currently support the Full 
Screen mode. On browsers that don’t support the Full Screen mode the 
Full Screen Control bar is displayed with the menus shown.  To simulate 
the full screen mode the browser screen can be maximized and toolbars 
and menus can then be hidden. 

 
   To access the menus:  

Position the mouse over the control bar at the top of the screen 
and click the left button for control, right button for view.  
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Control Menu (left mouse button) 
      Back                         

Go back to last slide shown.  
      Pause           

Pause/restart slide show.  
      Forward       

Go forward one slide.. 
      Stop                          

Stop current action.  
      Reload         

Reload the current image, document or URL. 
 
View Menu (right mouse button) 
       Start Show    

Start the SlideShow.  
      Color...         

Change the color of the status bar on the top of the screen.  
This is normally black but can be changed to match the 
background color of the web browser.   

 
Menus Visible (center mouse button) 
      Menus Visible          

Make the menus visible. Useful when you want to use the 
shortcut keys in the full screen mode.  

 
Tip: To change the background color in Internet Explorer, change the 

View/Internet Options/Colors/Background color option. If changed to 
black then images will appear in a field of black. 

 
      Controls... 

Brings back the main SlideShow screen.  
      Normal Size 

Returns the browser to normal size and reopens the main 
screen.  
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Browser Type       
The Browser Type screen allows you to choose the web browser that 
SlideShow will use to display slides.  SlideShow supports the recent 
releases of Microsoft’s Internet Explorer and Netscape’s Navigator.   
SlideShow will also work with many DDE compliant browser that follows 
the Spyglass Software Development Interface.  This interface is composed 
of a number of generic, platform independent automation actions that lets 
SlideShow control the browser’s actions. 
 
SlideShow will use either DDE or OLE automation to control the browser 
depending on the browser and operating system. Typically OLE offers 
more automation features and controls compared to the DDE interface.  
 
Choose the browser and version that you wish to use and that is installed 
on your computer. If you do not know the version of your browser then 
open the browser and select the About menu selection under the Help 
menu.  
 
Browser Version 
Internet Explorer          

Version 2     IE version 2, (the original — limited support) 
Version 3     IE version 3 
Version 4/5   IE version 4 or 5, OLE support in Windows 95/98 
 
Note: The original version of Windows 95 shipped with Internet Explorer Version 2 

reported the version as 4.40.xxx This is not version 4 of Internet Explorer. If you are 
using the original Internet Explorer that came with your computer that is more than 3 
years old it is most likely version 2.  

 
Netscape Navigator       

Version 2     Netscape version 2 
Version 3     Netscape version 3 
Version 4     Netscape version 4 

 
Other DDE Compliant Browsers 

If specifying a DDE compliant browser then:  
• The browser must be installed and registered with Windows. 
• You need to know the DDE application name of the browser.  
For a current list of supported browsers, check the SlideShow FAQ on 
the Beagle Software web site.  

 
Application Executable           DDE executable name  

Program name for executable. Enter the program name including 
the “.exe” extension.  

Browse              
Find the DDE program in the Windows file system. Look under the 
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Program Files section for a start.Do not select shortcuts. 
 

Hint: Use the find utility under the Windows menu if you have 
trouble locating your browser.  

 
Application Name         DDE specific application name.  

Hint: Often the application name is the same as the executable 
name without the “.exe” suffix. 

 
Automation Window  

The automation window shows the type of automation that will 
be used (DDE or OLE) to control the browser. The automation 
depends on the supported automation methods for the browser 
selected and the operating environment.  

 
Test Button 

Test the browser selected. This will attempt to start the newly 
selected browser.  The browser you were using should stay  
active after the test. 

 
OK button 

Saves the new browser type.  SlideShow makes the following 
checks when a new browser has been selected: 
• Checks that the browser selected is installed and 

registered in Windows. 
• Unloads the browser currently running.  
• Attempts to start the new browser. 
• Even if the test start of the new browser fails, the new 

browser settings will be saved when you press ‘OK’. Upon 
restarting SlideShow the new browser will be started.  

 
Help                  For on-line help. 
Cancel               Cancels any changes and return 
 
 
 
 
 
 
 
 
 
 
 

Registration Screen (Trial versions) 
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The Registration Screen shows the current status of your evaluation period and 
presents registration options. It is displayed whenever the product is under 
evaluation and not yet registered. 
Pro Version 
Select this button to find out more about SlideShow Pro. Registered users are 
automatically upgraded to the Pro Version when they register their software. 
Register Now button 
Select this button to begin the registration process. 
Enter Code button 
Once the software is purchased you will be given a unique Key Code to enter to 
register the software internally. Select this button when you are ready to enter the 
Key Code. 
OK button 
Closes the screen and continues to run program. 
Quit/Cancel button 
This exits the registration process. The quit button, when presented, exits the 
program. 
 

Enter Key Code Form (Trial versions) 
This form receives the entry of the product key code, required to register the 
software internally. The key code is given to registered users of the software. The 
key code enables the license for the SlideShow Pro version of the software.   

Key Code Input Field 
Enter the code exactly as it was written observing all capitalization and 
punctuation. Press the <Enter> key or the OK button when done. 

 
Ordering Information Screen (Trial versions) 

The Ordering Information Screen describes the various ways to purchase 
SlideShow software.  

Web Site button 
This button starts the local web browser to open the Beagle Software order page. 

E-Mail button 
This button starts the local E-mail portion of the Web browser to request an order 
form from Beagle Software. 

Order Form button 
Presents an order form from the help system that can be filled out,  and then 
mailed, E-mailed or faxed to Beagle Software for software registration. 

Cancel 
Returns to the main registration screen. 

 
About Screen 

Shows product version and copyright information 
OK button 
Closes the screen. 
System Info 
Presents the Microsoft System Information screen, giving information about the 
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system. Microsoft System Information is a basic tool for gathering system 
configuration information.  

 
Splash Screen 

The Splash screen displays product and version information and is displayed 
only at startup. 

 
Tip Screen                

The Tip screen displays the "Tip of the Day" -offering tips in the use of the 
SlideShow application. 
OK button 
Closes the screen. This button will save any changes you have made to the Tip 
screen. 
Next Tip button 
Shows the next tip from the tip database. 
Show Tips at Startup checkbox  
Check this box if you want the tips to appear at program startup. This check 
box also appears under the display tab of the options screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



22 

beagle software 

Show Reference 
Wizard Start Screen 
The Wizard start screen is the first screen shown when the New Show wizard is 
started from the Wizard menu or at program start. It lets the user choose an exist-
ing slide show or create a new show. 
 
Types of shows that can be begun with the wizard: 

• new shows  
• web shows  
• image albums 
• shows from bookmarks 

 
Recent Tab 
                Current- Opens the last show viewed.  
 
            Show List  
            Shows a list of recently opened shows.  

Includes the show file name, number of slides and the last show modification 
date.  
Click on the show file name to choose the show to load. 

 
            More 
            Opens up the file dialog to find a slide show in the file system. 
 
New Tab  

Pressing the New Show button starts the New Show wizard which walks 
you through the process of creating either a locally run show or a web 
based show. The process of making a new show is broken down into a 
series of steps.  Each of the options ends at the appropriate screen for 
making the type of show desired.   

For those making a web show, the Make Web Show  screen is presented 
with the options filled in based on the answers given to the wizard’s ques-
tions. Show options can then be reviewed and the web show files can be 
generated. 

Show Wizard at startup 
Loads the Wizard start screen each time SlideShow is started.  The Wiz-
ard can also be started at any time from the Wizard menu. 

Cancel 
            Returns to SlideShow main screen. 
Help 
            Presents on-line help.  

Wizard Screen 
This form offers instructions and options for questions in the Wizard. Generally, it 
is necessary to select both the option (Yes, No) and also press a navigation key 
(Next, Back, Cancel) at each step. 
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Wizard Input Screen           
This form offers instructions and asks for input for questions in the Wizard. Gen-
erally, it is necessary to fill in the field or fields and press a navigation key (Next, 
Back, Cancel) at each step. 

Show Editor  
The Show Editor screen (File->Edit) allows you to edit individual slides 
in a show. You can open shows and manipulate the slides in the show. 
Slides can then be individually selected for editing, viewing or playing. 
Dragging a slide into a new position in the list will also change the order 
of slides.  Slides can also be created by dragging a file from another 
program onto the slide list. 

Editing Toolbar 
The Show Edit toolbar contains the major options for editing slides and 
shows:  

Open Open another show. 
 
Save Save the changes to the current show to file.  
 
Edit Edit the document, sound file or pause time for the slide.  
 
Add Create a new slide at the end of the collection. 
 
Copy Create a copy of the highlighted slide and insert it below 
the existing slide. 
 
Insert Insert a new slide immediately below the current slide.  
 
Skip When running the show, skip this slide.  When a slide is 
designated as skipped the icon changes to a yellow warning 
icon. Skipped slides remain in the collection but are not played 
in the show. When the show is re-opened skipped slides are 
reset to the normal play mode.  
 
Delete Delete the slide from the show.  This does not delete 
the original image or document, just the reference to the file in 
the show. 
 
View Show the current slide document in the browser.  
 
Play. Play the sound file of the current slide and open the 
Play/Record screen.  
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Slide List 
Shows a list of slides in the show. When played in Sequential orders lides are 
played in numeric sequence.  To select a slide in the list click the left column (the 
slide number) of the slide to select. 

Columns 
Number - Number of slide in current show. This number is assigned when 

the show editor is started. If you change the order of the slides then the 
next time the slide editor is opened the numbering of the slides will 
reflect the new order. 

 
Slide file - Path of the slide document to show in browser. 
 
Sound file - Path of the optional sound file to play.  
 
Pause  - Individual pause time for this slide in seconds. 
 
Shown - Number of times this slide has been shown since last loading or 

saving the show. 
 
Last shown - Time (24-hour format) slide was last displayed. 

 

Hints 

• Press the leftmost "Number " column to select the slide. 

• Hidden rightmost columns show usage information.  

• Expand the slide list and form by dragging the left edge of the screen to 
the right.  

• Selected slides can be deleted, skipped, copied, viewed or played from 
the toolbar. 

• Shows can be alphabetically sorted by any of the column headings by 
clicking on the column title. 

• Double click the slide to open the edit slide form. 

• Once selected, slides can be dragged into a new position. 

• Right clicking the mouse will give the slide edit options in a pop-up 
context menu. 

• Image or other file types can be dragged from Windows  and dropped into 
a show.  
To drag and drop a file into the Show Editor: 
               Select the file from   Windows Explorer.  
               Hold the left mouse button down as you drag the file over the 
slide list box of the show editor.   
               After you release the mouse button the file will be added as a 
slide at the end of the show. 

 
OK        Update the current show with the changes. 
Cancel    Press to cancel any changes made on the show and return. 
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Add / Edit Slide Screen 
The Edit slide screen permits users to edit and add individual slides. 
The screen allows for changing the slide document, sound file or the 
pause time 
 

Slide 
Enter the URL or complete file name of the document to view. 
Slides can also be defined by dragging a file from another 
program into the slide list box. 
Tip: If specifying a file resident on the local computer, be sure 
to use the full path including the drive letter. The browser then 
knows it’s a file: for example: C:\Program Files\Beagle 
Software\SlideShow\Data\beagle.jpg.  
 

Slide toolbar 
Select  a new slide 
View  the slide document  in the browser.  

Sound file 
Enter the file name of the sound file to play. Sounds can also 
be defined by dragging a file from another program into the 
slide list box. 
 
Tip: Unlike the slide file name, the sound file name can use a local 
path relative to the location of the program. For example: Data
\welcome.wav.  
 

Sound file toolbar 
Select another sound file  
Play the sound file and open the Play/Record screen.  
 
Pause Time 
Slide pause time. Enter the time in seconds to display the 
slide. 
 
Note: The pause time is the time to pause from the beginning of the 
loading process to the loading of the next slide. 
 

Skip file 
Check to skip the slide when playing the show 

 
OK 

Press to keep the changes on this slide and return. 
Cancel 

Cancels any changes and return to previous screen. 
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Play / Record Sound 
Play and record sound files used to accompany slides.  Sound files serve 
as an accompaniment or background to the show slides. They can be 
music, voice or any kind of wave file supported by the native sound card.  If 
the sound card has recording capability then speech or music can be 
recorded to use in shows. 
 
Note: A sound card and supporting hardware must be installed for the 
sound feature to work. 
 
Record Panel 

This panel contains the recording buttons. 
     Record 

Records a new sound file or rerecord over an existing sound file.  Once 
you press the record button then the "In Service" light will come on 
indicating that recording is underway. Press the stop button to end 
recording.  Replay the new recording with the Play button. 

 
Technical Note: Recording is done using 8 bit PCM at a 11 kHz 
sampling rate. 

      Stop 
Press to stop recording. (Only enabled during recording.) 

 
Play Panel 

This panel contains the playback controls. 
        Play 

Press to play the phrase shown in the sound file field.  
 

        Left/Right Volume slider 
Adjust the left/right channel volume.  
 

Note: The volume settings are the same settings used by Windows and 
will affect other applications that use sound.  

 
       Sound File 

Enter the complete path and file of the wave speech file phrase to 
play or record 

       Open  
Open the file dialog to choose a sound file.  

       Play  
Play the current sound file.  

       OK 
Save the changes made to the sound file and return.  

      Cancel 
Exit screen, not saving changes  
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Make Show from Directory  
 
This screen (accessed from the File->New menu) lets you make a 
show quickly of any collection of files on your computer.  The make 
show utility creates a show with each file listed in a single slide.  The 
utility does not copy the files -- it creates a reference to the files in the 
slide. The files themselves can be changed or modified after the show 
is created. The show will be automatically updated as long as the file 
name stays the same. 
 
You can make a new show from any directory containing files that are 
viewable in the web browser, including images (JPEGs, GIFs), web 
pages (HTML), text files and any other file formats that are supported 
by the browser.  The target directory can contain a mix of these files.   
 
After selecting the directory a slide is made containing a reference to 
each of the files. Accompanying sound file and pause time can be 
specified  for each slide after the show is generated.  
 
Note: To make a show from files or web pages from different directories  
create a new file (File->New->New Show) which opens the Show 
Editor 
 

   Choose Drive  
Select the drive containing the directory. This can be a fixed 
hard drive, floppy drive, CD-ROM or external storage device 
like a Zip drive.  

   Up button 
Move up a directory level. This will ‘move up’ the directory tree 
towards the main directory. 

   Directory List 
Displays all the directories in the selected drive.  Clicking on 
the yellow folders will expand directories. Choose the directory 
to make a collection from by clicking it once with the mouse, 
then pressing the OK button.  

   All Files / Selected Files options  
The All Files option automatically selects all the files within a 
directory when you press the OK button.  If you want to select 
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individual files then use the Selected Files option. The Selected 
Files option will let you choose individual files in the directory with 
the mouse in the File List box. 
 
Note: The All Files option adds slides in order that the files were 
created, the oldest files are first and the most recently created 
files last. The Select Files option sorts files alphabetically by file 
name.  

Path - Selected Directory 
Shows the directory selected to make a show from. There 

must be an entry in this field for a show to be made either by  
clicking on a yellow folder in the directory tree or by manually 
entering the directory path and name in the field.  

Filter 
The file selection filter determines which files in the selected 

directory will be shown in the file box. The default filter ‘*.*’  
shows all files in the directory.  To select only the web pages in 

the directory change the filter to ‘*.htm’. The filter only works 
when the Selected Files option is selected. 

 
Hint: In addition to using wildcard characters ‘*’, you can also 

use multiple patterns separated by semicolons (;). For example,  

*.gif;*.jpg  in the filter would return a list of JPEG and GIF 
image files for a given directory. 

File List 
The file list gives a listing of all files that have passed through the 
filter in a directory. These files, when selected, will be included as 
slides in the slide show. Files selected should be in a format that 
can be displayed by the browser.  
The file list is active only when the Selected Files option is 
selected. 
• To select individual files click on the files once with the left 

mouse button.  
• To select multiple files individually hold down the Cntrl key 

while pressing the left mouse button.  
• To select a range of files select the top file with the left mouse 

button then select the bottom file in the range by pressing the 
Shift key while pressing the left mouse button. This will select 
the files selected and those in between 

• Selected files are shown in highlight. 
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• Use the Filter (described above) to select files of a specific 
type or name.  
 

OK 
Press to make show from directory and files selected.   
• If the All Files option is selected a show will be generated 

from all files in the selected directory. There must be files 
present in the directory.  

• If the Selected Files option is chosen then only selected 
(highlighted) files will be included in the show. There must be 
at least one file selected for a show to be created.  

Cancel 
Cancel this screen and return.  

Help 
For on-line help.  
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Make Web Show  
With this form (accessed from the File->Save As->Web Show  menu) you 
can make a web show from an existing slide show. Using the existing 
collection of slides, SlideShow  will can generate two web pages, a start 
page and a web show page. The start page provides the starting point in 
the show, the first page from which to begin the show.The web show page 
contains the show engine and references to all the slides in the collection.  
SlideShow does not generate the actual web pages for the show - it uses 
the existing files, images and web sites to display.  The same sound files 
included in the slide show can be played by the web show if the browser 
supports playing of wave files.  
 
Running a show involves moving through the sites or files using the web 
show control page generated by SlideShow.   
 
To make a web show:  

• Create a slide show, edit and review it. 
• Select the options for the web show and run the web show audit. 
• Generate the web show from this form by pressing the Make Show  

button.  
• Test the web show using the Test button on this form. 
• Relocate the web show by copying the two HTML files where they will 

be used.  
• Copy any image or sound files referenced in the show to the correct 

location on the web server. 
Hint: You can also use the new show wizard to guide you through crea-

tion of a web show.  
 

Show Type 
Locally based show  

Show will be run locally on this computer using a web 
browser instead of SlideShow. 

Web based Show  
Show will be posted and viewed on the web. 

Starting Web Page  
 Start Page 

File name of the starting or “home” page of the web 
show. Typically ends in “.htm” or “.html” 

Start Automatically 
Starts the web show automatically when the Start Show  
button on the Start Page is pressed and the show con-
trol windows is opened.  This is equivalent to the user 
pressing the Auto button when the web show control 
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page is opened.  

Local Directory to place  Web Show Pages    
Path   

Directory in which both web pages will be placed.  
Browse           

 Select a directory for the web pages. 
 

Relocate files with the following path 
Web based shows must reference files with respect to the web 
and cannot contain references that are set in the Windows file 
system -- for instance files referenced to c:\my documents will 
not work on the web.  
This filter allows you to replace the references to the local 
paths to those used on the web site. For instance you might 
change the reference from  c:\My Documents\Pictures\  to  im-
ages/.  
When the web page is created the references for each slide 
will be checked and any slide with path specified will have its 
path altered in the web show by the filer.  
Note that the filter changes only the reference to the files in 
the web show and does not relocate or change the files them-
selves.  
 
Replace: 

Specify the path that will be found and replaced in 
the current show.  

With: 
Specify the new path (if any) on how the slides will 
now be referenced.  

 
Hints:  
To check for locally referenced files, first run the Audit button 

on the make web page form. 
To reference a local path use a dot ‘.’ In the With box to indi-

cate the local directory when replacing an absolute path 
(a path with drive letter and colon.) 

To remove a local path from slides in a show enter the path to 
be removed in the Replace  box and leave the With box 
empty. 

Web Show Page Settings  
Web Show Page: 

Filename for the web show page. Typically ends in “.
htm” or “.html” 
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Show Title:     
Enter the page title. This will be the title shown in the 
web show page. 

Pause Between Slides:  
Specify the interval between web pages during the 
show.  

Sound:           
use sound   Play sound file with page, if available 

Audit 
Runs the web show audit using the current show and the settings 
selected. For an explanation of the report see  the web show Audit 
Results section that follows. 

Make Show 
Press to generate the web show. Generates the two web pages 
with the names specified in the form. After creating the show a 
dialog will be displayed confirming the creation of the two HTML 
files in the directory specified.  

Test 
To view the new show in browser press the Test button. This 
opens a new browser window and loads the start page, the “home 
page” in the web show. This page contains a button to call the web 
show page which starts the web show.  

Cancel            
Closes the form. 

Help    
For on-line help. 

Audit Results 
The web show Audit performs a multi-step test on the currently selected 
show using the settings on the form. It checks the number and types of 
slides.  
 
Sample Output: 

File Title: Show08-11-99 

------- Web Show Files -------- 
Starting Web page name: StrtShow.htm 
Show Control page name: WebShow.htm 
Show Control page title: MyTitle 
Directory to copy web show files from: C:
\Program Files\Beagle Software\SlideShow\Data\ 
 
------- Slide Information -------- 
Files with local paths (potential access prob-
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lems):  
C:\WINDOWS\TEMP\bottom.htm 
 
Number of web pages in show: 2 
Number of referenced files in show: 19 
Total number of slides in show: 21 
Pause time between slides: 10 sec 
Approximate length of show: 210 seconds. (3.5 
minutes) 
There are no sound files in any of the slides. 

 
Explanation of Fields: 

File Title: Name of original SlideShow 

Web Show Files Information: 
Starting Web page name: Starting page for show. 

File name of 1 of  the 2 files generated by Slide-
Show. 

Show Control page name: Name of the page that 
contains the actual show and control buttons. 

Show Control page title: Title of the web show 
page. 

Directory to copy web show files from: Di-
rectory where the show files will be placed. 

Slide Information: 
Files with local paths (potential access 

problems):  
    For web based shows, a listing of slides that have 

absolute paths (i.e. c:\directory) 
       In almost all cases these paths will be inaccessible 

or incorrect from the web and should be changed. 
 
Number of web pages in show: Number of URLs 

in show. 
Number of referenced files in show: Number 

of files (images, documents etc) referenced in show. 
Total number of slides in show: Total slides. 
Pause time between slides: Time of pause be-

tween slides in Auto mode. 
Approximate length of show: The product of 
the number of slides and the pause time.  
There are no sound files in any of the 
slides. Results of the show scan to see if there 
were any sound files referenced in  the original show. 
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Technical Reference 
Starting SlideShow Automatically  
You can run SlideShow automatically to allow you to set up a show that will  
start and run with the show and options you want. Automatically running 
shows require no user interaction and are therefore suitable for installa-
tions in displays and kiosks. 
Shows can be run one time or run continuously. Slides can be shown in 
order or shown randomly. Slides can be individually timed or all have the 
same default timing.  The show can start in the full screen mode with the 
controls hidden, or in the normal mode with the controls in view. The fol-
lowing options are available to start SlideShow automatically: 
 

• Auto Start Option 
The Auto Start option, available from the main SlideShow screen, 
starts the current show automatically the next time SlideShow is 
started.  The show will begin as soon as SlideShow is started and 
will exit when the show is complete if the 'show once' option is se-
lected. 
 
• Starting from the Command Line 
SlideShow can also be run from the command line allowing it to be 
started from batch scripts or other programs. 
 
• Show Instruction File 
SlideShow can also be started from the command line with an in-
structions file specified. This instructions file overrides the current 
settings to run SlideShow with the options called out in the file.  
Show selection, show starting slide and show timing can all be 
specified in the show instruction file.  

 

Command Line Mode 
You can launch SlideShow from the command line (Windows 95/98/NT Run com-
mand or MS-DOS prompt): 

SlideShow can be run with the following optional command line arguments: 

<program_path> SlideShow.exe  [debug] [options <options file>] [fullscreen] 

Arguments: 

debug – run SlideShow in the trace mode. 

options <options file> run SlideShow with the options specified in the 
options instructions file 

fullscreen Start SlideShow in the full screen mode. In the full screen 
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mode the browser fills the entire screen and the main SlideShow 
screen is hidden behind the browser 

 

Instruction file Reference 
SlideShow can be started from the command line with an options file specified. 
This options file overrides the current saved settings to run SlideShow with the 
options included in the options file. The options file consists of a list of label/
value pairs for specifying the values of the options to be set. Any options not 
explicitly set in the file will use the previously saved values for the options. 

An options file of the current options settings is created from the Save to file… 
selection under the Options menu. 

Generic format:  

“Option”, value  

Where option is a predefined system option name and value is the ac-
tual value for the option. 

Formatting Requirements:  
Each Option,Value pair must be on a separate line. 
Options must have quotes  surrounding the name (i.e. “ToolTips”); 
option names are case sensitive. A comma must separate options 
and values -- do not use spaces or tabs. 
Values: string values must also be quoted (i.e. “IEXPLORE”), Boo-
lean values (true or false) must be either #TRUE# or #FALSE#; nu-
meric values  (i.e. 4) need no formatting. Note: Using a value out of 
range can have unpredictable results. 

Sample format: 

"ReloadInterval",10 
"ReloadMode",1 
"CarouselMode",2 
"CarouselOperation",1 
"CarouselFileName","C:\temp\Show08-11-99.txt" 
"StartingAddress","http://www.beaglesoft.com” 
"StartingSlide",3 
"DisplayTips",#FALSE# 
"DisplayWizard",#TRUE# 
"BusyWait",#FALSE# 
"AutoStart",#TRUE# 
"UseDefault",#TRUE# 
"ToolTips",#TRUE# 
"AutoMode",2 
"AutoDDEexe","IExplore.exe" 
"AutoDDEapp","IEXPLORE" 
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Option Description Sample Value Choices/Type 

"ReloadInterval" Pause time between slides 10 Seconds. Non standard 
values will often function 
correctly but will not be 
displayed correctly in the 
control. 

"ReloadMode" Type of show action: AutoReload 
of same slide (2), or slide chang-
ing carousel (3) 

3 OFF = 1 
AUTO = 2 
CAROUSEL = 3 

"CarouselMode" Sequential or randomly ordered 
slides 

2 SEQUENTIAL= 1 
RANDOM = 2 

"CarouselOperation" Once or continuous show loop. A 
show showing once will exit when 
done. 

1 ONCE = 1 
CONTINUOUS = 2 

"CarouselFileName" Name of show loaded at startup. "C:\temp
\Show0899.txt" 

Valid SlideShow file 

"StartingAddress" Address or filename of document 
to be displayed in browser window 
at startup. Usually same reference 
as StartingSlide. 

"http://www.
beaglesoft.

com” 

Valid address or file 
name. 

"StartingSlide" Number of slide to set in controls 
at startup. (See StartingAddress 
for document to be displayed in 
browser at start.) 

3 Number of slide in cur-
rent show. 

"DisplayTips" Show tip of day screen at startup #FALSE#  #TRUE# or #FALSE#  

"DisplayWizard" Display the new show wizard at 
startup. 

#TRUE#  #TRUE# or #FALSE#  

"BusyWait" Wait till done loading before load-
ing next slide. 

#FALSE#  #TRUE# or #FALSE#  

"AutoStart" Start show automatically at 
startup. 

#TRUE#  #TRUE# or #FALSE#  

"UseDefault" Use default reload time  #TRUE# #TRUE# or #FALSE#  

"ToolTips" Show tool tips when mouse over 
occurs. 

#TRUE#  #TRUE# or #FALSE#  

"AutoMode" Type/Version of browser in use. 2 Browser version: 
IE  v2 = 0; v3 =1; v4/5=2 
Netscape v2=3;  v3=4; 
v4=5 
Other DDE=6 

"AutoDDEexe" Executable name "IExplore.exe" Valid executable name of 
browser 

"AutoDDEapp" OLE or DDE application name  "IEXPLORE"  OLE or DDE name for 
browser. 
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Placing a Web Show on CD 
Web shows can be created and placed on CD-ROMs,  Zip drives, floppy 
disks  and other removable media. This allows you to create and distrib-
ute shows to anyone with a web browser. Since the web show is self 
contained on the media there is no need for the person viewing to have 
SlideShow or even a PC! 
 
To create a stand-alone show to be placed on CD-ROM:  

• Create, edit and test a show using  SlideShow.  
• Create a  web show from the slide show.  
• Place the web show files on the CD-ROM 
• Place all the referenced files or images on the CD-ROM. 

Your users can start their show by simply selecting the start show page. 
You can also make a CD-ROM self booting by adding a configuration 
file in the CD-ROMs boot directory, using an autorun.inf file. Contact 
Beagle Software support  for more information about the bootable CD-
ROM setup.  

Importing and Exporting Bookmarks 
SlideShow can import a bookmark file generated by Internet Explorer or 
Netscape Navigator to be used in creating a new slide show.  When im-
porting bookmarks, SlideShow reads the file and makes each link in the 
bookmark file a separate slide.  Individual slides can then be edited to 
add sound, change pause time or change the overall order of slides in a 
show.  

Exporting a show to a bookmark file lets you translate a slide show for 
use as a list of bookmarks in Netscape Navigator or Internet Explorer. 
When exported each slide will appear as a link in the bookmark file, 
which is a standard web page. 

To export a show to bookmark file in SlideShow: 

1. Chose File->Import and Export->Export bookmarks 

2. Pick a directory and a name for the bookmark file.  

3. SlideShow will create a bookmark file from the existing slide 
show creating a link for each slide in the show.  

To import a bookmark file into SlideShow: 

1. Chose File->Import and Export->Import bookmarks 

2. Find the bookmark file to import. 

3. SlideShow will create a new show, creating a new slide 
from each link in the bookmark file.  
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REFERENCE  

To save a bookmark file in Internet Explorer (version 5 and above): 
File -> Import and Export… 

                        Starts the Import/Export Wizard 
            Import/Export Selection 

                        Pick Export Favorites 

Export Favorites Source Folder 

                        Pick the folder where the favorites are located 

Export to a File or Address 

Specify the file name.  

Bookmarks in Netscape Navigator 

Netscape Navigator automatically saves bookmarks in a file, 
bookmark.htm, located in the Users profile directory off the Net-
scape program directory. 

User Guide 
Ways to Use Slide Show 
Browse a list of favorite web sites 
SlideShow can quickly run through your favorite web sites quickly and 
easily. 

As a presentation tool 
Present multimedia shows that mix web sites, images documents and 
sound files for a dynamic presentation tool.  

As an image browser 
SlideShow can scan directories of JPEG’s or GIF files easily. Make 
collections of your favorite images for regular viewing. Make an album of 
favorite images with your own voice over narration. 

As a training tool 
Set up an instructional show to demonstrate the web, software or anything 
else.  Include interactive html components and instructional voice-overs. 

As a demonstration program 
SlideShow can demonstrate your favorite web sites, software or images. 
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To give guided tours of the web 
SlideShow can walk users through web sites to show them special sites 
or as a way of demonstrating how the web works. 

To make web shows 
SlideShow can create stand-alone web shows to be run on the web 
or distributed on CD-ROM or other media. 

Features of the Pro version 
SlideShow Pro is an advanced version of SlideShow. Registered users 
are automatically upgraded to the Pro Version when they register their 
software.  The new Pro version features include: 

• Unlimited show size 
SlideShow Pro has no limit to the number of slides in a 
show.  

• 180 days technical support 

• Free upgrades within release (i.e. 1.x .x) 
Users are notified via E-mail of all major releases. 

Making a Multimedia Slide Show 

To make a multimedia show using SlideShow: 
1 Select a theme or focus of the show 

2 Select the URLs, images or documents 

3 Order the images in the show 

4 Create a slide for each frame of the show 

5 Select and record music or record voice narration for the 
slide 

6 Run the show advancing through each slide to test the 
order and the juxtapositioning of slides in the show. 

Making a Web Based Show       
Making a web show is as easy as saving a file. SlideShow takes the 
show that you have already prepared and makes a HTML based show 
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that can be run by any Java enabled web browser, including later versions 
of Internet Explorer and Netscape Navigator.  

A web show can be opened from any web browser by opening the web 
start page, which contains a link to the web show page. The web show 
page contains the show’s navigation controls and references to all the 
slides in the show. The show opens each site or file and pauses for time 
period specified before loading the next slide. The slides can contain the 
same documents as make up a regular slide show: web sites, images or 
regular files.  

You can also add sound to play with the slide. The sound file is opened in 
a separate window and is played as soon as the site is opened. The 
browser must support ‘wav’ files for the sound file to be heard. 

Web Show Uses 
•       Make public slide shows and put them on your web site.  

•       Make self-contained slide shows on CD-ROMs, Jazz disks or 
even floppy disks! 

• Trade collections of favorite web sites 

• Make  Guided Tours of the Web with Voice Over 

• Quickly make tutorials or instructional  web based guides  

How it Works 
• User opens start page with web browser.  

• User starts show by pressing “Start Show” button, opening show 
window 

• Show page contains the controls for navigating the slides in the 
show.  

• User presses a navigation button, for example the 'Auto` button. 
Show loads the slide and displays it in the main browser window.  

• User can open a single slide from the pull down slide list or by 
entering the number in the slide number window.  

• When done, user presses the ‘End’ button, closing the show 
window and returning to the start form. 

The Web Show Controls 



41 

SlideShow User’s Guide 

<<Prev and Next>> buttons move backwards or forwards in the 
show. 
Auto will start the automatic SlideShow, advancing through each 
slide.  
Pause will stop a show at the current slide. 
Hide will send the navigation window behind the active window.  
End will end the show, close the navigation window and return to 
the start page. 

The controls provide a subset of the same controls used in 
SlideShow:  

• Manual Mode - Move within shows using forward and back 
buttons, by selecting a slide from the pull down menu, or by 
entering the slide number in the window.  

• Auto - Pressing the Auto button starts the timed sequence 
of slides. Each slide is shown in the order they were listed 
in SlideShow. Slides pause for the time requested. Every 
slide is shown in order. The show wraps to the beginning 
when all slides have shown. 

Deploying a Show on the WWW 
The web show feature lets you create stand-alone shows that can be 
deployed on the Web.   

To put a show on the web: 

1. Prepare show  in SlideShow 

2. Edit and test show in SlideShow.  

3. Open the Web Show creation screen directly from the file menu 
(File->SaveAs->WebShow) or by using the New Show Wizard.  

4. Run the Audit on the prospective show. Check the show for lo-
cal paths (which won’t work on the web.) 

5. Generate the 2 web show pages by pressing the Make Show 
button.  

6. Test Web Show by pressing the Test button.  

7. Move start show page and web show page to web site 

8. Move referenced slides to web site carefully observing the 
placement path (if any). 
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9. Link the Start Show page to other web pages. The start show page 
gives users a starting point for running and ending the show.  

Tips 
• A web show that only references external web sites has only two 

HTML pages - a Start Show page and a Web Show page. 

• Browsers have differing display characteristics and vary widely in 
their rendering of HTML pages and files. Check the show by 
viewing with several different types of browsers. 

• Browsers have different security properties and may react 
differently to file permissions and paths when files are included in 
shows. 

• Referenced files not in the same directory as the show files may 
need to have a complete web path to be found by the browser. 
Netscape Navigator is very specific about the type of path it ac-
cepts. 

• Putting all files (show files and documents) used for a web show in 
the same directory is often the best way to get things going 
quickly. 

• While sound is an exciting addition to web based shows, sound 
files are extremely large and can take a long time to download.  

 

 

 

 

 

 

 

Show Control Options        

During a show, the showing of slides can be controlled in a variety of ways. 
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The following list the different ways that a user can control an actual 
show:  

From the Main Screen: 

• Navigation keys on control bar.  

• Using the Control  menu options. 

• Using shortcuts (i.e. Control+B = Back)  The shortcut, when 
available, is shown in the right column of the pull down menu.  

• By dragging the slider on the show control bar.  

• With the right, middle and left, mouse buttons when the cursor 
is moved over the remote control icon on the navigation control 
bar.  

From the Full Screen Control Bar:  

• Using the mouse buttons to access the popup Control and View 
menus: 
Left mouse button contains the control functions (forward, back, 
pause). 
Shortcuts are shown when the menus are visible. (Make the 
menus visible with the middle mouse button.) 
Show and display options are available under the View menu.  

Note: The main screen can also be kept visible when in the full 
screen with the Keep on top  option available from the View 
menu.  

 

 

 

Technical Information 
How SlideShow Works      

The following is a summary of the steps SlideShow performs 
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when a slide show is run:  

1. SlideShow is started. SlideShow starts a copy of Internet 
Explorer or Netscape Navigator and establishes an automation 
link. 

2. A slide show is started by the user pressing the  “Show” button 

3. SlideShow runs the slides in the slide show collection 

4. The browser displays the slide.  

5. The sound file (if any) is played in background.  

6. The system pauses the seconds specified in the pause time 
field if specified or pauses for the default time period if none is 
specified or “use default” is selected. 

7. SlideShow goes through all the slides in the collection if in the 
sequential mode or randomly selects the next slide if in the 
random mode.  

8. SlideShow will end after the last slide if showing “once”, or will 
start over if in the continuous mode. 

System Demands of SlideShow  
The demands of SlideShow, when used in most modes are minimal.  

Internet Traffic: SlideShow adds no additional Internet traffic other than 
the demands made on its behalf by the native web browser.  

System Resources: SlideShow spends most of its time in the sleep mode, 
waiting for the next slide to be shown or waiting for user input. SlideShow 
uses one of the native operating system timers, which are finite in number.  

Testing has shown that most users experience approximately a 1% 
increase in system utilization when viewed by the NT System Monitor 
when in the sleep mode with less than 5% increase when actually running 
a show.  

SlideShow Specifications  
System Requirements  

• Windows 95/98, Windows NT (Service pack 3 or later) or Windows 
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2000 

• Microsoft Internet Explorer or Netscape Navigator web browser 
installed.   SlideShow will also work with most DDE compliant 
browsers – check the Beagle Software web site for a list of 
browsers. Version 4 or 5 of Internet Explorer offers several 
additional display features, such as full screen theatre mode, 
which can be controlled in SlideShow through OLE automation.  

• Sound card with speakers and microphone if sound 
accompaniment is desired.  

 

Techical Support 
Troubleshooting 

Image won’t display 

Web site is unavailable, connection is down or web address is 
wrong.  
Slide file is in incorrect format. Try opening directly from web 
browser.  
The web browser is incompatible.  

Browser starts but won’t work with SlideShow 

The browser has a correct application path specified but the 
automation between slide show and the browser is not active.  
Try a different setting under the Options->Browser menu on the 
main screen. Some older browsers (like Internet Explorer version 
2) have limited functionality. For best results the latest version of 
the browser should be installed.  

My browser won’t start with SlideShow 

Not all browsers have the necessary automation hooks that 
SlideShow needs to control a slide show.  If your browser won’t 
start when SlideShow starts then try selecting the DDE compliant 
setting under the Options->Browser menu and find the program 
path using the Browse button. For a list of compatible browsers 
check the Beagle Software web site. 

Certain features in SlideShow aren’t available to me 

SlideShow uses program to program automation to control the 
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slides in a show. There are two ways of automating that control, 
DDE and OLE.  OLE is the latest means of automation and has the 
richest feature set that allows for full screen mode, multiple show 
windows and slide load progress monitoring.  DDE is an older 
technology and does not have the full feature set available that 
OLE automation offers.  To check what kind of automation you are 
using check the automation window in the Browser Type screen 
under the Options->Browser menu.  

Internet Explorer won’t stay minimized when show is running  

In the DDE automation mode, each time a slide is displayed  the 
browser screen is displayed -- even when the browser was 
minimized and in the taskbar.  This is a characteristic of the DDE 
automation implementation in Internet Explorer. 

Program focus regularly shifts to browser when show is running 

In the show mode, every time a slide is displayed causes the 
browser screen to briefly get program focus (browser banner 
changes to the active color) during each slide loading. This is a 
characteristic of automation process.  To pause the action to allow 
access to other programs use SlideShow’s Pause or Stop control 
buttons. 

There is no sound, though sound file is assigned 
Speech file is missing or path is incorrect. 

Speech file is in an incompatible format.  Try playing the file by 
double clicking it and playing it with the default Windows player.  

Speech card inoperable. Verify sounds in Windows control panel. 

Web Based Shows Fail to Run 

Most problems with web shows involve references to slides which 
include full path names (i.e. C:\images\myslide.jpg). Invariably, the 
directory path on your webserver is different from your Windows file 
system so avoid using paths in specifying slides. Before creating a 
web show, check that all the slides in the Show Editor have no 
path. If you must use a path, use a relative path (i.e. \images
\myslide.jpg) Generally, it’s easier to create Web Shows when all 
the slides have no path (i.e. myslide.jpg) and are located in the 
same directory on the web server.  

Make sure that the directory you are using on the web server is 
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accessible publicly from the web. To verify this uou should be 
able to view a slide by entering its URL in your browser. 

Sound and music files are typically very large and are often 
impractical for web shows since the time needed to download the 
sound file would be excessive. If you do use sound in web 
shows, keep it short! 

Registration screen appears at startup  

Software has not been yet been registered, registered software 
will skip the Registration screen.  

The Windows System Registry has been altered or corrupted, re-
enter the Key Code to re- register.  

SlideShow Diagnostic Routine 
If you are having problems running SlideShow, you can run SlideShow in 
the diagnostic mode that provides a trace log to pinpoint problems. The 
following steps will run SlideShow with the diagnostic trace turned on and 
allow you to view the trace file. (DebugFile.txt) 

1. Exit SlideShow if currently running.   

2. Restart SlideShow in diagnostic mode by adding the ’debug’ 
argument to the command line, typically:  

C:\Program Files\Beagle Software\SlideShow\SlideShow.exe debug 

3. Choose the DemoShow or another show. 

4. Run the show by pressing the Show button. 

5. Run the application till an error is encountered. Exit the 
application. 

6. View the diagnostic trace by opening it  in Notepad. The debug 
file can be found in the root SlideShow directory, usually: 

C:\Program Files\Beagle Software\SlideShow\DebugFile.txt  

7. Check for “ERRORS” or problems in the trace.  

8. Contact Beagle Software for assistance in interpreting the trace 
and pinpointing the problem. 
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Obtaining Technical Support 

Web site 
Latest product updates and technical information are available on 
the Beagle Software Web site at  
http://www.beaglesoft.com 
 

E-mail 
Send E-mail requests for technical support to  
support@beaglesoft.com.  Please be as specific as possible 
including the program version and the steps to recreate the 
problem, if possible.  
 

Phone 
voice: (612) 377-9356 
fax: (612) 971-2312 
 
 
 
 

Beagle Software 
 

General Information 
Beagle Software, founded in May 1997, supplies 

innovative and useful Internet enabled Windows 
programs that bring the power of the Internet to the 
desktop of the user. 

 

Beagle Software is located in Minneapolis, Minnesota, 
just slightly West of the Mississippi River. 
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Ordering Information 
Ordering over the Web  
        http://www.beaglesoft.com/OrderForm.htm 
Ordering via E-mail:  
        sales@beaglesoft.com 
Ordering by Mail:  

Beagle Software 
1946 Sheridan Avenue South 
Minneapolis, MN 55405 
USA 

Ordering by Fax  
+1 612 971-2312 

Ordering over the phone 
+1 612 971-2112 
+1 877 845-2549  toll free (US) 
 

Warranty/License Agreement 
SlideShow® Copyright ©  1997-1999 by Beagle Software. All rights reserved. 
 

License Agreement  
You should carefully read the following terms and conditions before using this software. 
Use of this software indicates your acceptance of this license agreement and warranty. 
For information on distributing the shareware evaluation version of SlideShow see the 
section titled Shareware License. 
 

Registered Version 
One registered copy of SlideShow may either be used by a single person who uses the 
software personally on one or more computers, or inst alled on a single workstation used 
non simultaneously by multiple people, but not both. 
 

Limited Warranty 
Limited Warranty. Beagle Software warrants that this product will perform in accordance 
with the included documentation for a period of 180 days  from the date of receipt and that 
Beagle Software will, at its own discretion, shall make commercially reasonable efforts to 
solve any problem issues.  This Limited Warranty is void if failure of the software product 
has resulted from accident, abuse or misapplication. 
 

Governing Law 
This agreement shall be governed by the laws of the State of Minnesota. 
 

Limitation of Liability 
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND 
WITHOUT WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR 
ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED, NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED. 
Good data processing procedure dictates that any program is thoroughly tested before 
relying on it.  The user must assume the entire risk of using the program.  ANY 
LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT 
REPLACEMENT OR REFUND OF PURCHASE PRICE. 
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Other Products from Beagle Software 

CallWatch 
Saves Money on Long Distance Calls by ‘Dialing 
Around’. 
 
‘Dial Around’ service saves customer’s money by offering rates less 
expensive than the customer’s regular long distance company. CallWatch 
picks the best rate available, automates the dialing, and then keeps track 
of calls and call cost. 
 
CallWatch provides a way to keep track of the companies’ rates, using its 
internal database it selects the company with the best rate for the time of 
day the call is being made and the place the call is being made to. 
Registered users of CallWatch have access to the latest rate tables from 
Beagle Software's web site, giving them access to call rate changes from 
all the major ‘Dial Around’ carriers. Trial users of CallWatch have 
experienced savings of 15 to 66% percent off their regular monthly long 
distance bill.CallWatch takes the hassle and grunt work out of using ‘Dial 
Around’ services.  
 
CallWatch:  
 
• Picks the best company with the lowest rate for the place and time 

called, in or out of state.  
• Automates dialing the 7-digit access code and the phone number over 

regular phone lines.   
• Times calls and keeps track of their cost.   
• Stays up-to-date with the latest changes in rates, new promotions and 

companies including monthly service charges.   
• Allows users to view call usage by carrier.   

• Includes a powerful contact manager, with key word search capability, 
that stores phone numbers and notes about conversations. 

 
CallWatch is available for Windows 95/98/NT 
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ClockWatch  
Keeps your internal computer system clock synchronized 
with the National Atomic clock. 

ClockWatch provides a fast and easy way to synchronize your computer system's 
clock to standard time over the Internet.  
 
ClockWatch queries one of the timeservers maintained by the National Institute of 
Standards and Technology, which returns the exact standard time.  Settings can be 
made on demand, on a regularly scheduled basis or automatically based on the 
specific experience of the local system. You set the level of accuracy desired and 
ClockWatch checks the time when appropriate.   
 
Results from clock settings are graphically displayed in windows and charts showing 
the overall accuracy of your computer. Results of clock settings can also be logged to 
a file allowing you to save all activity in a text file on your computer for later review or 
archival. A command line mode allows users to run ClockWatch from a batch file. 
 
“Highly Recommended” PC Computing 
 
ClockWatch is available for both Windows 95/98 and Windows NT.  

 
 
 

ClockCard 
Real Time Clock on a PC Card 

Beagle Software's ClockCard is an accurate, temperature stable 
real time clock complete on a PC card.   

Use ClockCard to dramatically improve the accuracy of your 
computer’s clock. The ClockCard is a real time clock for PCs based 
on a highly stable oscillator circuit complete with lithium battery  
power.  

The ClockCard will maintain time on your PC to 15 seconds/month 
error. If your computer is operating in a temperature stable 
environment, error will be less than 5 seconds/month.  

The most common application for ClockCard is to simply maintain 
the correct time on the host computer. When installed with Clock-
Watch, it will set the Operating System clock to the ClockCard clock 
time at a user-defined interval. This allows the O/S and all applica-
tions to access to the correct time. Updates to the ClockCard’s inter-
nal clock can be done automatically with ClockWatch.            
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Contact Information 
 
Web Site 

http://www.beaglesoft.com 
 

Electronic mail  
General Information & Sales:  
            sales@beaglesoft.com 
 
Reseller Information: 
            reseller@beaglesoft.com 
 
Customer Support:  

support@beaglesoft.com 
 

Postal address  
Beagle Software 
1946 Sheridan Ave. South  
Minneapolis, Minnesota  55405  
USA  
 

Telephone  
+1 612 971-2112 general 
+1 612 377-9356 support 
+1 877 845-2549 sales (Toll free US) 

 
FAX  

                        +1 612-971-2312  


